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USB - 6000 Specifications: Analog Input

Number of analog inputs 8, single-ended
[nput resolution 12 bits
Maximum sample rate (aggregate), 10 kS/s

system-dependent

Converter type Successive approximation

Al FIFO 2,047 samples

Timing resolution 125 ns (8 MHz timebase)
Timing accuracy 100 ppm of actual sample rate
Input range 10V

Working voltage =10V

[nput impedance >1 MQ
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USB - 6000 Specifications: Analog Input

Overvoltage protection £330V
Trigger sources Software, PFI 1
System noise! 10 mVrms
Absolute accuracy at full scale, single-ended
Typical at 25 °C 26 mV
Maximum over temperature 135 mV
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USB - 6000 Specifications: Digital Input

Number of digital /0
Function
P0.0O/PFI 0
PO.1/PFI 1
P0.2
P0.3

Direction control
Output driver type

Absolute maximum voltage range
Pull-down resistor

Power-on state

Digital Input

Input voltage range
Powered on
Powered off

Input voltage protection

Master de Ingenieria de Telecomunicacion

Static digital I/O or counter source
Static digital 1/0 or Al Start Trigger
Static digital /O

Static digital /O

Each channel individually programmable as
input or output

Each channel individually programmable as
open collector or active drive

0V to 5 V with respect to D GND
47.5 kQ to DGND

Input

OVto5V
OVto33V

+20 V, for up to 24 hours
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NI-DAQmMx

LabVIEW LabWindows™/CVI C/C++ C# VB .NET

NI-DAQmx Driver Software

(ncludes MAX, Virtual Char A ant

PCl | PClExpress | PXI | PXIExpress | USB | Ethernet @ Wireless

Uata Acquisnt
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Crear dispositivos simulados
en NI-MAX
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= Dispositivos simulados

?4 Devices and Interfaces - Measurement & Automation Explorer - O x

File Edit View Tools Help
<

v E3 My System Ay Create New..
[&l Data Neighborhood
v g Devices god ntacfacan

N i 1) Create New..  Dayjces and Interfaces

“dl Scales Devices and Interfaces lists installed and detected CAN, DAQ, FieldPoint Serial Controllers, GPIB, IVI,

&1 Software Motion, Serial, ISA, Vision, and VXI hardware.
B8 Remote Systems

If you do not see your devices...

= You have not refreshed the configuration tree
= Yourdevice maynotbe Windows Plug and Play compatible

What do you want to do?

% Configure an existing device

= Add a non-Plug and Play device

For more information about using your NI productin MAX refer to your product-specific help, located on the
Help»Help Topics menu item.You can also access NI product help from within MAX help, which you can
launch from the Help menu or by pressing <F1=.

Sistemas de instrumentacion
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= Dispositivos simulados

L V'E o dilild LETIaLES EdaUle ent &L AT =] CALNUINE

File Edit View Tools Help
v B3 My System ""I_'] Create Mew...
[§l Data Neighborhood
v @ Devices and Interfaces [l
== M| Simulated D
4 Metwork Device
a4 Scales
&1 Software Choose the type of item you want to add.

B3 Remote Systems

EE Create New ...

Elﬁll Devices and Interfaces
== Network NI-DAQmx Devices
=
i NIFRTSI Cable
Port (Senal or Parallel)
a5 VISA TCP/IP Resource
B NI GRIB-ENET/1000
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Dispositivos simulados

*=
L4 Y
File Edit View Tools Help
v E1 My System

[§l Data Neighborhood

~ & Devices and Interfaces
NI Simulated DAC Device "
4 Metwork Devices

J'I'_'] Create Mew...

Devices and Interfaces

|
Devices and | TE Create Simulated NI-DAQmx Device
Motion, Serial,

44 Scales
53 Software
EA Remote Systems

NI-DAQmMx Simulated Devices

If you do n

----- ¥ Series DAQ

M Series DAQ

5 Series DAQ

- 5C Express

- B Series DAQ

. USBDAQ

MI USB-6001
MI USB-6002
NI USB-6003
- NI USB-6008
NI USB-6009
NI USB-6501
- NIUSB-9201

= You have n
= Yourdewce

What do y¢

== Configure a
= Add a non-H

For more infor
Help»Help Toj
launch from th

ecomunicacion

|
FieldPoint Serial Controllers, GPIB, VI,

to your product-specific help, located on the
help from within MAX help, which you can
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«: Dispositivos simulados

‘E NI USB-6000 "Dev6” - Measurement & Automation Explorer

File Edit View Tools Help

v Ed My System (=] K}' Refresh | 3 Reset E'J Self-Test [] Test Panels... | [% Create Task... =E- Device Pinouts
[§ Data Meighborhood
v B Devices and Interfaces
NI USB-6000 "Devs” .
A Network Devices Settings
44 Scales
63 Software
[ M1 Drivers Name Dev6
ES Remote Systems
Vendor National Instruments
Model NI USB-6000
Status Simulated

Sistemas de instrumentacion
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* n n H
E NI USB-6000 "Dev6" - Measurement & Automation Explorer
File Edit View Tools Help
v E3 My System = ,'e.' Refresh | 3 Reset E‘J Self-Test [] Test Panels... | {% Create Task... =B- Device Pinouts
[gl Data Meighborhood
+ B Devices and Interfaces
NI USE-5000 "Devé" .
A MNetwork Devices Settings
44 Scales
& Software
il V1 Drivers Name Dev6
E3 Remote Systemns
Vendor National Instruments
Model NI USB-6000
Status Simulated
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NI-DAQmMx y MAX (Measurement and Automation Explorer)

 NI-DAQmx es el driver que nos permite
comunicarnos desde el PC con la tarjeta.

* NI-MAX software se usa para configurar y
comprobar los dispositivos hardware.
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NI MAX: Test panels

I - ve
+ L] Test Panels : NI USB-6000: "Dev6" X

Analog Input  Digital 1/0  Counter /O

Channel Name

Amplitude vs. Samples Chart Auto-scale chart
Devé/ai0 v 8.6
Mode
On Demand v -8.8-
Input Configuration -9
RSE v
Max Input Limit Min Input Limit -9.2-

10 -10

= Start Stop
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Test panel: Analog Input

 Channel name: Se configura el canal en
el cual se va a llevar a cabo la lectura

* Input Configuration:

— Differential: modo diferencial para sefnales
flotantes. El modo diferencial se usa para
senales diferenciales, sefales pequenas o
senales degradas.

— RSE: Medida referenciada a tierra.
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Test panel: Analog Input

 Mode:

— On demand: Lectura de muestras de una en
una usando una senal de reloj software

— Finite: Se adquieren un numero finito de
muestras usando el reloj hardware interno

— Continuos: adquiere un numero ilimitado de
muestras usando el reloj hardware interno

Master de Ingenieria de Telecomunicaciéon Sistemas de instrumentacion



Test panel

« “Rate” and "Samples to read”

— Solo se aplica en los modos “finite” y
“continuous”.

— Rate: Frecuencia de muestreo

— Samples to read: Numero de muestras
totales durante una adquisicion finita. En el
caso de una adquision continua se esperara
a tener el numero de muestras indicadas
antes de realizar la representacion.
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MAX: Scales

|
| P& NI-DAQmMX Scales - Measurement & Automation Explorer

File Edit View Tools Help

v B My System "'I_'] Create Mew NI-DACmMz Scale..,
~ [g Data Neighborhood
@ MyDigitalOutChannel_1 NI-DAQmx Scales
@2 MI-DACmx Global Virtual Channels .
[ MI-DAOmM:x Tasks 4 M‘}"SCH'E

W @ Devices and Interfaces
¢ NI USB-G000 "Deve"
4 MNetwork Devices
w o dg Scales
[+d] MI-DACMx Scales
a Software
[l VI Drivers
Ed Remote Systems
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74 NI-DAQmx Scales - Measurement & Automation Explorer

File Edit View Tools Help

v B3 My System J"I_‘| Create New MI-DADmx Scale...
v [ Data Meighborhood
@) MyDigitalQutChannel_1 MNI-DAQMx Scales
& MI-DACMz Global Virtual Channels f(_’ C p)
i, Create New ... ? X
i NI-DAQmx Tasks “dMyScale

NI USB-6000 "Deve”

Metwork Devi ; ‘
' ork Devices Z inear

Select the type of scale to use in the measurement.
w g Scales

Customn scales specify a conversion between a scaled value and a
w [aa] MNI-DAQMx S phenomenon & device measures or generates. Far example, the ~~ Map Ranges
ar pressure of an ideal gas in a closed container is related to its

“ M}rSCE|E 'u_l_l| Create NEW N|-DAQ”'IX Scale... | temperature. You can create a virtual channel to measure h’ PO|yn0mia|

temperature and use a customn scale that converts that

temparature to = pressure re=ding.
& Software >
" Table

When using a customn scale in an application, specify the minimum

m [V Drivers and maximum value in terms of the scaled units. For input
operations, the custom scale is used to convert the real world units
Ed Remote S}rstems into your scaled units. For output operations, the custom scale is

used to convert your scaled units into real world units.

® Linear—Scales values by using the equation y=mx+b, whers x

is a prescalad value and y is 3 scaled value.

® Map Ranges—Scales values proportionally from a range of

prescaled values to a range of scaled values.

®  Polynomial—Scales valuss using an nth order polynomial

equation.

® Table—Maps an array of prescaled values to an array of
corrasponding scaled values, vith all other values scalad
proportionally.

< Back Next > Finish Cancel
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MAX: Virtual channels

=
L%

File Edit View Tools Help

v B My System 74 Create New ..
+ [q Data Neighborhood

@ MyDigitalOutChannel_1 .
[ NI-DAQmx Global Virtual Channels Choose the type of item you want to add.
@ MI-DAC:x Tasks

W ﬂ Devices and Interfaces .
N USB-6000 “Det" E|[-INData Neighborhood
{3 NI-DAQmx Task

4 Metwork Devices
v 44 Scales i NI-DAQmx Global Virtual Channel

v [ad] NI-DAOmMx Scales
a4 Amp
ag MyScale
53 Software
B V1 Drivers
B3 Remote Systems

Sistemas de instrumentacion
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Virtual channels

 Virtual channels

— Los canales virtuales globales son entidades
de software que encapsulan el canal fisico
junto con otra informacion especifica del
canal, como rango, configuracion de la
terminal y escala personalizada.

« Un canal virtual asigna informacion de
configuracion como la escala y los limites de
entrada.
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«=x \irtual channels

74 Create New NI-DAQmx Global Virtual Channel... ? X

=@ Acquire Signals A

Select the measurement type for the global virtual channel.

A global virtual channel maps configuration information, such as 2 Analoq |HDUt
scaling and input limits, to a specified physical channel. E Voltage

Temperature

Strain

Current

Resistance

Frequency

Position )
Sound Pressure

Acceleration

Velocity (IEPE) '
Force

Pressure

Torque

Bridge (V/V)

Custom Voltage with Excitation

Charge

Counter Input

Digital Input

w TEDS v

R e e T

< Back MNext > Finish Cancel
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«=x \irtual channels

= .
% Create New NI-DAQmx Global Virtual Channel... ? X
NATIONAL
INSTRUMENTS
B Physical
Select the physical channel to use for your new global virtual
channel. Supported Physical Channels
If you have previously configured globsl vittual channels of the E" Devs (USB-6000) ~
same measurement type, you can click the Virtwal tab to add or a0
copy the infermation from an existing global virtual channel. Ei
If you hawve configured TEDS channels, you can click the TEDS - I
tab to use a TEDS channel for your new global virtual channel. I
- @4
- 1]
- ar
L
< Back Next > Einish Cancel
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Virtual channels

R Voltaje - Measurement & Automation Explorer

File Edit View Tools Operate Help

| ¥ B My System
|~ |5l Dsta Neighborhood
@ MyDigitalOutChannel 1
~ [& NI-DAQmx Global Virtual Channels
i} Voltaje
(@ NI-DACMx Tasks
~ @@ Devices and Interfaces
NI USB-6000 "Devé"
4 Network Devices
w 44 Scales
w [ MI-DACrx Scales
44 Amp
a4 MyScale
5] Software
[ VI Drivers
EA Remote Systems

=] | £ Run ~

Channel

Value

Valtaje

Table ~ | Display Type

Configuration

Channel Settings

Detais | ||~

Voltage Input Setup

Settings
Signal Input Range
. Scaled Units
M,
= Valts
Min -10

Terminal Configuration
RSE

~

~

Custom Scaling
<No Scale>

all

iR NI-DAGmx Global Channel d Description £ Connection Diagram

nicacion
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MAX: Tasks

¢ ‘ NI-DAQmx Tasks - Measurement & Automation Explorer

File Edit View Tools Help

v B3 My System 'i'l_'] Create Mew NI-DAGmx Task...
v [g Data Meighborhood
@& MyDigitalQutChannel_1 MNI-DAQMmMx Tasks
v [m MI-DACmx Global Virtual Channels
= Voltaje [E MyVDItageTask
Gl NI-DAQr=~Rock- ltageTas
v & Devicesand| 77 Create New NI-DAQmx Task j
Nl USE E'l.r'w LS Bt T1 '-MTT'I L ItageTaSlll
4 Metwork Devices Py
o o Seles {#MyVoltageTas...
v (@ NI-DAGm Scales {#MyDigitalOut...
agd Armp
a4 MyScale
& Software
[l V1 Drivers

Ed Remote Systems
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e Tasks

— Una tarea es una coleccion de uno o mas
canales, asi como la temporizacion, el
disparo y otras propiedades que aplican a la
tarea.

— Una tarea es una coleccion de canales con
propiedades similares.

— Los canales que componen |a tarea pueden
ser utilizados en multiples tareas (canal
global) o asignado a una tarea especifica
(canal local).
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74 Create New ... ? K

=@ Acquire Signals A

A task is a collection of one or more virtual channels with timing. = Anﬂlog |HPUt
triggering, and other properties. E VOItage

Select the measurement type for the task.

To have multiple measurement types within a single task, you
must first create the task with one measurement type. After you Temperature
create the task, click the Add Channels button to add a new . Strain
measurement type to the task. 74
& Current
&= Resistance
& Frequency
Position
& Sound Pressure
Acceleration
dx

Velocity (IEPE)

Force

Pressure

Torque

Bridge (V/V)

Custom Voltage with Excitation

Charge

Counter Input

Digital Input

@ TEDS v

@ R

ey s

< Back Next > Finish Cancel
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74 Create New ... ? X

B Physical @) Virtual

Select the global virtual channel(s) to add to the task.

Supported Global Channels

MAX Channels A
Voltaje

¥ou can add existing glebal virtual channels or copy information
from existing global virtual channels to virtual channels local to
the task. Only glabal virtual channels that match the
measurement type of the task appear.

Select Add Global Channels to add existing global virtual
channels to the task.

Select Copy Global Channels to copy information from selected
existing glebal virtual channels and create local virtual channels
in the task.

For hardware that supports multiole channels in & task, you can
select multiple channels to add to the task at the same time.

v
(@ Add Global Channels
(_i Copy Global Channels
<Ctrl= or <Shift> dick to select multiple channels.
< Back Next > Finish Cancel
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Configuration  Triggering ~ Advanced Timing  Logging
Channel Settings
+ XN Detzis ¥ | ™| Voltage Input Setup
'..-,: Voltaje Settings
Click the Add Channels buttor —
(! fo add more channels fo Custom Scaling
the task. f——
W — (@
Timing Settings
Acquisition Mode Samples to Read Rate (Hz)
Continuous Samples s ik 10

Master de Ingenieria de Telecomunicacion
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Al realizar una adquisicion con DAQmX, los datos se transfieren
primero desde el dispositivo DAQ a la memoria RAM del ordenador.
En el ordenador hay un buffer preasignado en la memoria RAM
llamado DAQmx PC Buffer. En este buffer se almacenan los datos no
leidos desde el nivel de aplicacion.

En modo continuo el valor de .
Samples per Channel DAQ Device

se utiliza para determinar el
tamano del

DAQmx PC Buffer si el tamafio del
buffer predeterminado no es
suficiente. Sin embargo, en la
mayoria de los casos, se utiliza el

tamano de buffer predeterminado y
se ignora este valor. DAQmx PC

Buffer Application

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion



Especifica en
segundos la cantidad
de tiempo hasta que
expira el
temporizador.

Un valor de -1
significa que el
temporizador interno
nunca expira. Se usa
un -1 si se usa una
senal de disparo y se
quiere evitar que
expire el
temporizador.

Configuration Triggering

Sample Clodk Settings
Sample Clock Type

Internal R

Additional Timing Settings

Timeout (s)
100 &

Advanced Timing Logging

Master de Ingenieria de Telecomunicaciéon
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n Save

£ Run |+ =+ Add Channels X Remove Channels

Amplitude
[ ]
1

-ID_I | I 1 | 1 1 | 1 | 1 | 1 | | 1 I 1 1 I 1

i} 5 10 15 20 25 30 35 40 45 50 55 &l 65 70 75 a0 85 90 95 99.9
Time

Graph ~ || Display Type AutoScale Y-Axis
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Labview
DAQ Assist
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<:] DAQmx - Data Acquisition
DAQ Assistant

[TASK [+ [chan]] ¥ e | ? |
e DONT DO

Task Const Channel Const Create Channel Read Write Wait
Timing Triggering Start Stop Clear
[=€] |=€] | [=¢] | [=€] I3
A=A =] c.c) Fad
Channel Node Timing Node Triggering Node Read Node Write Node
g=
L - ¥
L : 7 3
DAQ Assist Real-Time Dev Config Task Config/Ctrl Advanced
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DAQ Assist
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{# Create New ... ? M

= b €2 A
Select the measurement type for the 8 Acquire Signals

task. { B Analog Input
A task is a collection of one or more

virtual channels with timing, triggering, E VD'“QE
and other properties. o
# Temperature
To have multiple measurement types
vithin a single task, you must first create ek) Strain

the task with one measurement type.

After you creste the task, click the Add Current

Channels button to add a new

measurement type to the task. Resistance
Frequency
Position

Sound Pressure

Acceleration

e e R

ay Velocity (IEPE)
Force
v
< Back Next Finish Cancel
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DAQ Assist

&% DAQ Assistant

K)@‘-o_ +

Run Add Channels

{8 Express Task £ Connection Diagram

X

Remove Channels

o

litude

+||X ‘:7 Detais )’ &
Voltage

Click the Add Channels button
(+) to add more channels to
the task.

Timing Settings
Acquisition Mode
N Samples

Voltage Input Setup
Settings

Signal Input Range
Scaled Units

M 10
i Volts v

Min -10

Terminal Configuration

RSE v
Custom Scaling
<No Scale> ~ @
Samples to Read Rate (Hz)
~ 100 1k

<

Hide Help
. Back Lﬂj

Measuring Voltage

Most measurement
devices are designed for
measuring, or reading,
voltage. Two common
voltage measurements
are DC and AC.

DC woltages are useful
for measuring
phenomena that change
slovdy with time, such as
temperature, pressure,
or strain.

AC voltages, on the other
hand, are waveforms
that constantly increase,
decrease, and reverse
polarity. Most powerlines
deliver AC voltage.

B

Samples To Read
specifies the number of
samples to read when
you select N Samples.
When you select
Continuous, NI-DAQmx
uses Samples to Read
and Rate (Hz) to
determine buffer size.
Refer to the NI-DAQmx

OK Cancel

temas de instrumenta

X

~

A

~

v
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SRR DAQ Assist

[* ] untitled 1 Block Diagram * — O X
File Edit View Project Operate Tools Window Help %l
>& @ N @ 2 war@ 7 |15ptApplicationFont ~ | §ov dav EHv Bag »l Search A BB 1
~

v

|

DAQ Assistant
data ¥

Vv
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SRR DAQ Assist

39 Siral Manipulaion = ] B s L1

Convert from Dynamic Data Window Help Comparison Waveform Collection
EI @ Iﬁ! 15pt Application = o=
1 G - k
Merge Signals Split Signals Select Signals File I/O Timing Dialog & User
Interface
- = N Muestras adquir @
= 7 i : o - %
| Wasd H ‘o J
Align & Resamp Collector Sample Comp Y Synchronization Graphics & Application
Sound Control
~ oo !
0 ot P D

Trigger & Gate Relay Append Signals Waveform Grap Report

VHJ Generation
EEW H =
B ] o

Measurement |/O

>
Instrument /O 13
Repack Values Extract Portion Delay Values Mathematics »
Signal Processing »
wivhy l—*! Data Communication »
A i
- ; - Connectivity »
From DDT To DDT Group Signals Sig Manip A X
Control & Simulation »
EI ==

T LE Addons 2

Set Attributes Get Attributes Selecta V...

¥

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion
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SRR DAQ Assist

Ejercicio DAQ Assist

Usar el asistente para configurar la adquisicion de una sefial de voltaje. Configurar

1)
el modo de adquisicién “N Sample” en la tarea.

2) Construir el panel frontal mostrado en la figura.

Pioto 0% |

Waveform Chart Plot 0 m I Waveform Graph

10-, 10+
9-| 8-
v v ‘
38 3 Waveform Graph 2 .
= 4 e Waveform Graph
85 IE Waveform Chart 2 ,m
6 stop (F) et ,E vt J
o IS —
0 1 0 ‘
Time
AQ Assi
Waveform Chart 2 Voltage “ I Waveform Graph 2 D Q ssistant
10- 10- data
8- o
g 6- v
- E
& 4 &
E £ :
£, £ Waveform Chart
: 6 ]
%3
-2-) I 5-) 0 T
1:00:00,000 1:00:05,00) 0 02
01/01/1904 01/01/190) TR

Sistemas de instrumentacion
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. Configuracion de tareas en Labview

Canales

DAQmx Create Channel (Al-Voltage-Basic).vi

input terminal configuration
minimum value
maximum value
task in = Akt task out
physical channels
name to assign
units
error in
custom scale name

=== grror out

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion 42



‘‘‘‘‘‘‘‘‘‘‘ Transferencia de datos desde la tarjeta DAQ

AAAAAAAA

DMA/Interrupt transfer
Data acquisition card

s

To PC buffer

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion 43



DMA/Interrupt transfer

Data acquisition card l RAM (in the PC)
Data ADC |=—> FIFO Data > PC Application
| buffer buffer : > memory
From sensor sclk To PC buffer

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion



DAQmx Task Name
% |+

Master de Ingenieria de Telecomunicacion

7s DAQ Assistant_0
E&E MyDigitalOutTaskPulso

oa MyVoltageTask

PE MyVoltageTask_0
os MyVoltageTask_2
}."E MyVoltageTask_3

5 MyVoltageTask_4
Eﬁ MyVoltageTaskUMA_3

W

Sistemas de instrumentacion
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Create Constant

DAQmx Task Nar Create Control

I}ﬁ MyVoItageTaski Create Indicator

Visible ltems »
Change to Control

Change to Indicator
Change to Array

Make Type Def.
Description and Tip...

DAQmx - Data Acquisition Palette
Create

Data Operations

»
>
Replace »
»
Advanced »

 Size To Text

I/0 Name Filtering... - - S

New NI-DAQmx Task >

i
|
| Edit NI-DAQmx Task i i i e Y
|

Generate Code g Example

Configuration

I Select ftem.. ‘ Configuration and Example

‘ Properties | Convert to Express VI
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o Generar configuracion y cédigo de ejemplo
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{# DAQ Assistant

v o[ e . + X
Unde Fedo | Run Add Channels Remove Channels
{@ NI-DAQmx Task #: Connection Diagram
§ 1- "
3 -
E -1_I 1 1 [} ] I 1 1 1 1 1 I I 1 ] 1 I 1 1 I I
0 10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170 180 190 200
Time
Graoh w || Nisnlav Tvne AutoScale Y-Axis v
Configuration  Triggering  Advanced Tming  Logging
Channel Settings
+ X N petaic |~ | Voltage Input Setup
Voltage_0 Settings
Voltage_1
Voltage_2 Signal Input Range -
Voltage_3 Scaled Units
= 10
o Volts >
Min -10
Terminal Configuration
Gick the Add Channels button i &
(+) to add more channels to Custom Scaling _
the task. <No Scale> ~ Eﬂ
v
Timing Settings
Acquisition Mode Samples to Read Rate (Hz)
Continuous Samples v 1k 10k

stemas de instrumentacion
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Generar configuracion y cédigo de ejemplo

timeout (s)
10

___________________________________________________________________________________

JJJJJJJJJJJ

&5-00- -8 69
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~7=  Crear Canal virtual

DE MALAG

DAQmx Create Channel (Al-Voltage-Basic).vi Creates a virtual channel or set of virtual channels and adds them to a task.
The instances of this polymorphic VI correspond to the I/O type of the
channel, such as analog input, digital output, or counter output; the
measurement or generation to perform, such as temperature measurement,

input terminal configuration
minimum value
rmaximum value

task in task out
physical channelsj‘“‘ - . voltage generation, or event counting; and in some cases, the sensor to use,
. Error ou
name to assign |E such as a thermocouple or RTD for temperature measurements.
units
EITOr in . . o .
If you use this VI without specifying a task in, NI-DAQmx creates a new task

custom scale name

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion


lvhelp.chm::/using_polymorphic_vis.html

Ejercicio

1) Crear una tarea en Labview configurando una adquisicion de una seial de
voltaje del tipo “N muestras”, configurar un numero de muestras igual a
10000 y una frecuencia de muestreo de 10kHz. Configurar el timeout
correctamente.

Generar el cédigo de configuracion y ejemplo de uso de la tarea creada.

Crear una tarea en Labview configurando una adquisicion “continua” con 10000
muestras y una frecuencia de muestreo de 10kHz. Configurar el timeout
correctamente.

Generar el codigo de configuraciéon y ejemplo de uso de la tarea creada.

¢ Cuales son las diferencias entre ambos cédigos generados? ;Cual es el
objetivo del shift register?

2) Crear una tarea en Labview para la adquisicidon simultanea de 4 senales de
entrada de tipo voltaje, realizar una adquisicién continua, configurar 10000 y
una frecuencia de 10kHz. Generar el cédigo de configuracion y ejemplo de uso
de la tarea creada. Ejecutar el codigo resultante.

‘ ¢ Qué ocurre durante la ejecucion? N



Manejo de tareas

DAQmx Start Task.vi Transitions the task to the running state
to begin the measurement or generation.
Using this VI is required for some

error in == L2 e orror out applications and is optional for others.

task/channels in DAGmx task out

DAQmx Stop Task.vi Stops the task and returns it to the state
the task was in before the DAQmx Start
task/channels in "‘"‘"““imw'““ task out Task VI ran or the DAQmx Write VI ran
R Sp— { — orror OUk with the autostart input set to TRUE
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Manejo de tareas

DAQmx Clear Task.vi Clears the task. Before clearing, this VI
aborts the task, if necessary, and releases
task in ~—{Im any resources the task reserved. You
. {aar s cannot use a task after you clear it unless
error in error out

you recreate the task.

Si se planea realizar la misma adquisicion varias veces en el programa, llamar al
DAQmx Clear Task VI seria ineficiente en comparacion con el DAQmx Stop Task
V1. Con los mismos parametros fisicos y de tiempo, el método preferido es iniciar y
detener la misma tarea una y otra vez.

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion
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Disparo

DA mx
1]
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Configuracion de las propiedades de las tareas

DA s
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. Configuracion de las propiedades de las tareas

Erras IS & =< DA Channel o _ & =t DAGmx Read
| | Physicalchantiame* i [y IrMost Recent Sample *——*  RelativeTo
ChanType 4 Sample Clock | ' Offset
i AL Max
b ALMin
Al Voltage. Unibs  » P70 | PhysicalChantame]
L AT Resolutioniints_H——— | 3 = DAGmy Device
[DBLY L Active Channels {if subset) v Ackiveliey = oo {bevIsSimuIated|
Paximum Yalue Devlssimulated ¥+
&nalog Sukput 3 Minimum Yalue BusType r T -
Digital Input B | Custom Scale Mame | ALMaxSingleChanR.ate b
Drigital Cutpuk » Measurement Type ¥iEL | |81 MaxSingleChanRate]
Counker Inpuk 3 Yaoltage 3
Counker Cutput [ 3 Temperakure [ 3
General Properties [ 3 Current [ 3
Strain [ 3
Resistance »
TEDS »
General Properties  k

B w DAQME Timing 5

Ed 5 .. -
i b SampiClk, AckiveEdge H {n
Sample Clock, * Foampouant, Samphode

MaskerTimebase Fate K

LA
Analog Wwim E = —
1Chan M5amp n =% DACIT Sirite 5

CurrivritePos K
Spacedyal ¥

MasterTimebase, R.ate|

POBL]
Finite Samples ~
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o Adquirir datos del canal virtual

polymorphic VI

Propio de
National
DAQmx Read (Analog 10 Wfm NChan 1Samp).vi
task/channels in task out
—E
Errorin b error out
Reads a waveform that contains a single sample
from each channel in a task that contains one or
mare analog input channels,
Detailed help
Habituales
otras APIS

Master de Ingenieria de Telecomunicacion

Doubles
(ya

Waveform —The waveform data format includes the
channel name, timing, and unit information with the
actual 64-bit scaled floating-point data. Because there is
overhead associated with including this additional
information, NI-DAQmx allows you to configure the
information you want to include.

64-Bit Floating-Point Numbers—The 64-bit floating-point
number format allows you to read or write scaled data
with no additional information. Use this format to work
with scaled data that requires higher performance than

escalados) the waveform format provides. You might also use this

Integer
(Raw)

format because it is a better match for the libraries you
plan to use.

Unsigned and Signed Integers —The unsigned and
signed integer format reads or writes data in the native
format of the device. Use this format for maximum
performance. The tradeoff is that your application has to
understand how to interpret and manipulate data that is
not in engineering units.

Sistemas de instrumentacion



lvhelp.chm::/using_polymorphic_vis.html

Adquirir datos del canal virtual

DAQMx Read.vi data
taskfchannels in ':'1-: P |
N error ouk

J @nalog  » § . Single Channel p | ~ Single Sample
Digital — » Multiple Channels p
Counter p Unscaled »
More b

DEL
Multiple Samples  » BERLETEEET
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Tipos de datos: Waveform

El tipo de dato de waveform es un grupo compuesto por los siguientes
componentes:

|€? o {3 | 2011
Obtener componentes
de forma de onda

Tipo de dato de

forma de onda ] — L
1 POEL ||dt
L_ #oBL] Y J
Componente Descripcion
t0o Una marca de tiempo que representa el tiempo en que comienza la senal.
at Un doble numérico que describe la diferencia en el tiempo en segundos entre cada muestra en
la sefal.

Y Un arreglo de 1D de dobles que contiene los valores de las muestras de esa sefial.
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Transferencia de datos desde la tarjeta DAQ

Adquisicién de 1 muestra

La adquisicion de una sola muestra es una operacion bajo demanda. En otras
palabras, el controlador adquiere un valor de un canal de entrada y devuelve
inmediatamente el valor. Esta operacion no requiere de almacenamiento
temporal ni temporizacion hardware.

Adquisicién finita de N muestras

 Punto a punto. La transferencia de los datos adquiridos es inmediata. Los
requisitos de entrada/salida son mas exigentes de cara al bus utilizado.

 Adquisicidn de forma de onda. Se recomienda usar esta adquisicién que
usa un bufer en memoria y que permite, por tanto, adquirir datos con mas
eficacia. Se debe especificar la velocidad de muestreo y el modo de muestreo
(finito) en la funcion DAQmx timing VI.

Adquisicion continua
Si se necesita ver, procesar o registrar un subconjunto de muestras mientras se

adquieren, se debe adquirir muestras continuamente. Para este caso de uso de
debe configurar el muestreo continuo.

Master de Ingenieria de Telecomunicaciéon Sistemas de instrumentacion
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~==  Transferencia de datos desde la tarjeta DAQ

DAQmx Timing (Sample Clock).vi

samples per channel

sample mode Continuous Samples ~
task/channels in task out
rate @ error out 1000
source [EE
active edge '

rrerin Sample Clock ~

Sets the source of the Sample Clock, the rate of the
Sample Clock, and the number of samples to acquire or
generate,

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion
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Muestras por canal
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=  ¢COmo se determina el tamano del bufer creado por DAQmMx?

Tasa de muestreo Tamano de bufer
0-100 S/s 1 kS

100 - 10,000 S/s 10 kS
10,000 - 1,000,000 S/s 100 kS
> 1,000,000 S/s 1 MS

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion
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¢Como se modifica el tamaio del bufer creado por DAQMx?

task,/channels in task, ouk
buffer size {in samples per... ——
e ﬁbi errar auk

errar in
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Error de sobreescritura

Solucion: Aumentar el tamano del bufer, leer mas rapido o escribir mas
lentamente, patron de diseo Productor/Consumidor

T
obkain
Jueus Enquele Element
w
HE E.
E.. _D"‘E]'j_;. Produce data 1|

1= to be placed in )
: the quewe. Puk data
inko the

quELE

Dequeue Element

=0 ConsUme
Put data td:ta from
into khe & Queus

m quele
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. Error de sobreescritura

DE MALAGA

El buffer puede

estar sobreescrito \

l**-:lpen or create "l—"mD |j‘
1000 *
|Continuous Samples '$
s cDAQLMod1/ai0 H«T 10000 T
o [0000]" [ R e
Al Voltage ~ Sample Clock = Analog 10 DBL _ - ctatus
|AlVohoge ] |Somple Clock 7] il Y X
[ Stop[[TE]- 2%

El buffer no estara
sobreescrito \

w
I“ open or create ""I_ D

|

|

|

| 1000 * -}
| |Continuous Samples =
|

|

|

|

|

[ cDAQ1Mod1 /aiD [rf—f o

- &
Sample Clock "I

[

Analog IDDBL _| Ll Totares

1Chan MSamp

Stop [TER- 2% 1@

[
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Error de desbordamiento

Solucion: utilizar un mecanismo de transferencia de acceso directo a memoria
(DMA), disminuir la velocidad de entrada de datos solicitada o reducir la cantidad
de dispositivos que comparten el bus PCI
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Ejemplos

1. Muestreo de un numero finito de muestras punto a punto con un
temporizacion software

2. Muestreo de un numero finito de muestras usando un bufer con
temporizacion hardware

3. Muestreo continuo con bufer

4. Muestreo continuo con bufer e inicio de captura dirigido por disparo

Master de Ingenieria de Telecomunicaciéon Sistemas de instrumentacion



r“a Ejemplo 1: Muestreo de un numero finito de muestras

punto a punto con un temporizacion software

Loop Time {ms)
| uszﬂ

=

in Current
3

=

ax Current Waveform Chart

HJK MESS3QE + Warnings ™
Wﬂ Y~ e
Iy &
e ety ol (% |

AL Current A Analog 1D Wfm _
MChan 1Samp

o

hysical Channel

|
-
[l

esistor

I3

Value (Ohms)
[DELY

Channel Settings Acquire Data
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[ J [ I 4

=z Adquisicion software punto a punto

Loop Time (ms)

Min voltage
[ 1 Waveform Chart
Max voltage |
DELY M_H TOK message + warnings ¥
Physical Channel
1/0 e
* > &5 | |.¢
v {= ey o e W)
[l voitage ]| Analog DBL :
1Chan 15amp
m __.:: .....
Channel Settings Acquire Data
Channel Settings Acquired Data
Physical Channel
. P,I_J e l m‘J Waveform Chart
IEFIax voltage Min voltage )
\[2.5 I, \['2'5 H
<
£
£
' Timing Settings
Loop Time (ms) -
1100 IJ
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e Modificar las unidades del Eje X en un Grafico a Segundos

Terminal Configuration
| 1323

Min Voltage
|IE ¥ :
Max Violtage

IIE ] Waveform Chart

ﬁJK message + warnings ™
Physical Channel

/0 e

+—F

ol
nnny Waveform Chart '{@ .{@ ﬁ
AI Valtage = I — ‘ :

MiScale Multiplier ﬁ%ﬂ:ﬁ EEE:“B;. -

Channel Settings Acquire Data
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Modificar las unidades del Eje X en un Grafico a Segundos

Terminal Configuration
132

Min Voltage
I@ ¥
Max Voltage
I@ §

Physical Channel
/0 e

Waweform Chart
- FDEL]

—
nnn

10K message + warnings '}—L
Waveform Chart P{@ ﬁ%%: B ﬁ ,E
- i 7 7
AL Voltage #iScale Multiplier Analog 1D DEL :
MChan 15amp i

Channel Settings Acquire Data

et 2VEfOrm Chart

]
0.001 {-p ¥Scale
»

1 Jocooooo
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e Modificar las unidades del Eje X en un Grafico a Segundos

Caption »
Control Index
Data Binding »
DataSocket »
Description
Disabled
Focus Key Binding
,00p Time (ms) Reference Indicator
IIEI E Key Focus
Class ID l.: o >
Waveform Chart
| Class Name Owning Pane
b I’I Create Constant Ownfr Skip When Tabbing
7 Create Control Quning VI Synchronous Display
Create Indicator Bounds » Tip Strip
Visible ftems fncil ' :a:"e R
Find Indicator Display F + SRS W
E:_" :}l' i Y| visible
| Make Type Def. T XControl »
Flipped
Hide Indicator Format String
aui Active X Scal
quire Da Change to Control Mapping Mode : oty
Change te Constant Marker » Active Y Scale
Description and Tip... Marker Colors » Autcacals Delvy
Frame Color
Numeric Palette Range ’ Palette »
Array Palette s e Plot Area Bounds
| petrs ,
Data Operations Uniform Marker Spacing? Scale Legend >
Visibl
Advanced i Transpose Array
Gnid Colors » X Scrollbar Visible
Properties Loose Fit ¥ Scale »
Marker Values(]
MName Label » Active Plot
All Elements - R e
Offset and Multiplier Digital Display(s) Visible
Scale Fit Digital Display(]
Offset Unit Label . |
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e Modificar las unidades del Eje X en un Grafico a Segundos

Waveform Chart

plie .
Change All To Write

Find 4
Visible Items 4
Help For Praperty Node

Help For Offset and Multiplier :Multiplier

Description and Tip. ..
Sek Breakpoint

Waveform Chart

x
_____ 0
DELES
| DAG -
EE)
RAT ey
Analog Wm
1Chan N3amp
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o Modificacion valor inicial y delta del eje X

The graphs that use the default display behavior of the Waveform Graph are array data types. The graphs that define custom X-Axis
initial values and delta values are cluster data types.

Single Plot

B
== Multiple Plots
T o

A

50

Single Plot {customn time base)

Multiple Plots (custom time base)

InitiaIK-.ﬂxis\falue@ EH
Delta X p}——
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Ejemplo 2: Muestreo de un numero finito de muestras

usando un bufer con temporizacion hardware

D A o
Configure —»|  Stop Task L .
the Device {7

Start the

Acquisition

Return DA mix
Data from @
the Buffer 1NN
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jLks Ejemplo 2: Muestreo de un numero finito de muestras
usando un bufer con temporizacion hardware

AAAAAAAA

Configure Stop Task
the Device

Start the = Display
Acquisition n Errors

Return
Data from
the Buffer
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Ejemplo 2: Muestreo de un numero finito de muestras

usando un bufer con temporizacion hardware

samples per channel

- Waveform Chart
IFinite Samples ~ :
D:mel DAQmx — DAQmx Start  DAQmx DAQm Stop  Simple Error
Channel Mame Timing. vi Task. vi Read. vi Task. vi Handler . vi

rakte

Sample Clock "|

Master de Ingenieria de Telecomunicacion
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Analog 1D DEL _
1 Chan MSamp
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b Ejemplo 3: Muestreo continuo con bufer

samples per channel

n =0 DACmx Read n| AvailSampPerChan
AvailSampPerChan H-BISZ]|

Wavefarm Chart
DaQrx Channel DAQMX  pAQmx Start DAQmx Stop - Simple Error
Marme Timing.vi  Task.vi Task, vi Handler, vi
DA
rate @ ] — o 138
[DBLH— |Sample Clock =] Analog Wfm

1Chan NSamp
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Ejemplo 3: Muestreo continuo con bufer. Error de
sobreescritura

Aumentar el numero de muestras por canal (tamaifo del bufer) con el
DAQmx Timing VI. El aumento del tamano del bufer no resuelve el problema si
no se vacia el bufer lo suficientemente rapido (recuerda el configurar las muestras
por canal para leer a un cuarto o la mitad del tamano del bufer).

Vaciado del bufer mas rapidamente aumentando el numero de muestras por
canal para leer. No se debe establecer el numero de muestras por canal para
leer demasiado alto porque esperara en el DAQmx Read VI el numero de
muestras por canal en el bufer para igualar el numero de muestras por canal para
leer. El tiempo dedicado a esperar que las muestras llenen el bufer podria usarse
para vaciar.

Disminuir la frecuencia de muestreo por canal con DAQmx Timing VI. Esta
configuracion ralentiza la velocidad de envio de datos al bufer, pero podria no ser
una opcion si desea una determinada frecuencia de muestreo.

Evitar ralentizar el bucle de lectura con analisis innecesarios. Usar una
arquitectura productor — consumidor.
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1™  Ejemplo 4: Muestreo continuo con bufer e inicio de

UNIVERSIDAD

" captura dirigido por disparo

samples per channel

;: =& DAQmx Read 2 AvallSampPerChan
AvailSampPerChan Y-{#Usz]|

|Cortinucus Samples ~

Waveform Chart

DADmx Channel DAQmx | DAQmx Start DAGM ] DAQmx Stop  Simple Error
-N:arne Trigger.vi | Task vi Read.vi Task.vi Handler, vi
I’r:;nr
rate - {3
X Sanple Clock ~ Start Aralog WFm
Digtal Edge 1Chan NSamp
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Sincronizacion

La comparticidén de la senal de reloj es el método mas sencillo para sincronizar
las medidas y asegurar que los relojes de medicion nos se desvien con el tiempo.

Cuando se comparte un mismo reloj, el dispositivo que proporciona la sefal se
denomina dispositivo maestro. El dispositivo que recibe la sefnal se denomina
dispositivo esclavo. El uso de una arquitectura maestro esclavo permite que
todos los dispositivos detecten los cambios de temporizacion en los mismos
flacos de relo;.

Para asegurarse de que todos los dispositivos inician sus tareas al mismo tiempo
se debe asegurar que el dispositivo esclavo se configure y se ejecute antes
de que el dispositivo master inicie su actividad. Existen dos formas de
asegurar que esto ocurre:

« Hacer un merge de la salida de error del start de la tarea del dispositivo
esclavo con la entrada de error del start de la tarea del dispositivo maestro.

» Usar una estructura flat sequence e iniciar primero el start en el esclavo y en
segundo lugar el start del maestro.
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E MALAGA

Merge Errors

error in 0
errorin 1

inl
error in n-1 R

Merges error /O clusters from different
Vls and functicns.

error out

Detailed help w

Merge errors EREE >

Wiaveform Graph [
sample mode |32

rate 0 b

physical channels 0 source 0 q

FC)K MESSAgE + Warnings 'I

|
D&Qrnx Contral Taskawi |
i B
o ar 1 [Ei 58 | {252

Sample Clack = el Analog W
1Chan MSamp

&

samples per channel 1|(I321

|% fcDAQL aifStartTrigger [

rate 1 ] Wifaveform Graph 1

FC)K MESSAgE + Warnings 'I

FeDARL i SampleClock |+
P

phesical channels 1 DAQmx Triggerwi

= " e i
Sarnple Clock « Start Analog Wfm

Digital Edge 1Chan MSarp

Configure the task to use the
aifSarnple clock from the Master Task
in order to digitize data at the sarme
rate as the master, N,

|
|
|
|
|
|
|
|
| sample mode 1|(I32H
|
|
|
|
|
|
|
|
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Otras funciones basicas

m La tareas del NI-Daq: MAS Funciones basicas: Trigger para arrancar adquisicion
Start None

Configures the task to start acquiring or generating samples immediately upon starting the task.

task /channels in rﬂm kask ouk
L

errar in errar ouk

Trigger explicito. Un trigger de inicio comienza la adquisicion de datos
El trigger de referencia establece el punto de referencia en un conjunto de
muestras de entradas. Los datos adquiridos hasta el punto de referencia son datos

de pretrigger. Los datos adquiridos después del punto de referencia son datos del
posttrigger.

m La tareas del NI-Daq: Funciones extras de Labview: Almacenamiento de datos

DA Confi Leggi DMS).wi
Qmx Configure Logging (TOMS).vi Export Waveforms To Spreadsheet File (2D).vi

operation
task/channels in task out file path (dialog if empty) new file path (Mot A Path i...
fil E ef
fle path g error out wavererms error out
group name :

multiple time celumns? (sin...
errar in (no errar)

append to file? (new filesF)
Configures TOMS file logging for the task. header? (write headenT) -t

legging mede
EFFOT in
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DAQ avanzado con multiples bucles while

[Handle GUI Events|

|t ain Message Processor|

Display Window

A

[i]
Black - Messages transfer (using queue)
Blue . Data transfer using Queue (NB: queues have memory — no data is lost)
Red . Data transfer using Notifier (NB: notifiers do not have memory/FIFO)
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Raw 1D llo =
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DAQmx Read (VI)

L
tirmeouk &Lﬂhdata
I E— errar ouk

errar in
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Mumber of data points

EE—N
[Signal [zine plus noize]]
0 ' : g
L [
Fitered Signal 001 [ — .‘@”
Paint-By-Paint Initialize
7 Ao = |+>>-10BL |>
‘ 510l I> |> Ear—r | [Filtered Signal Paoint-By-Paint]
Signal ' r
[zine plus noise]
n n m
» 200
0 :I _:!mF i .

0.10

Master de Ingenieria de Telecomunicaciéon

Sistemas de instrumentacion



Analog 1D Wfm NChan 1Samp

£res]

data Se devuelve una matriz de formas de onda de una sola dimension (1D).
Cada elemento de la matriz se corresponde con un canal en la tarea. El orden
de los canales en la matriz corresponde al orden en que se agregan los
canales a la tarea o al orden de los canales que se especifiguen en la
propiedad “Channels to Read”.

NI-DAQmx escala los datos a las unidades de la medida, incluyendo cualquier
escala personalizada configurada en los canales. Se debe usar el DAQmMx
Create Virtual Channel VI o el DAQ Assistant para especificar estas unidades.
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Analog 1D DBL NChan 1Samp

fDEL]

data Devuelve una matriz 1D de muestras. Cada elemento de la matriz
corresponde a un canal en la tarea. El orden de los canales en la matriz
corresponde al orden en el que se agregan los canales a la tarea o al orden
de los canales que se especifique con la propiedad del Canal (Channel to
Read property)

NI-DAQmx escala los datos a las unidades de medida, incluida cualquier
escala personalizada que se configure en los canales. Se usa el DAQmMx
Create Virtual Channel VI o el DAQ Assistant para especificar estos valores.

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion



b Raw 1D U16

AAAAAAAA

data devuelve una matriz 1D de muestras enteras sin signo de 16 bits
EVi6] | sin procesar.

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion 90



Conversion manualmente de datos binarios en datos sin escala

Por ejemplo en una tarjeta de 16 bits de resolucién si su rango de voltaje es
bipolar (+/- 5V), entonces la lectura es la representacion con signo (116)
dentro del rango de -32768 a 32767 para la lectura binaria devuelta. (es
decir, Vmax = 5V, Vmin = -5V, bit = 16, lectura binaria = -8192, lectura de
voltaje = -1.25V)

Si su rango de voltaje es unipolar (0-10 V), entonces la lectura es la
representacion sin signo (U16) dentro del rango de 0 a 65535 para la
lectura binaria devuelta. (es decir, Vmax = 10V, Vmin = 0V, bit = 16, lectura
binaria = 8192, lectura de voltaje = 1.25V)
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Conversion datos binarios a datos escalados

Chart 2

Ll.F’.IJ

Tan
] PE.ca

E; =t DAQmx Read E; -.

» Relativelo

’ Offset Analog Wfm
1Chan NSamp

@7
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Conversion datos binarios a datos escalados

Finite Samples v|

ﬁ =L DAQmx Channel ﬁ

ML UIBV S CE L DETT b

Sample Clock *
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Raw data

El modo raw usa el formato nativo del dispositivo. Los datos se leen
directamente desde el dispositivo o el bufer sin escalar ni reordenar. El formato
nativo de un dispositivo puede ser un entero de 8, 16 o 32 bits, con signo o sin
signo.

Si usa un tamano entero diferente al formato nativo del dispositivo, un entero
puede contener multiples muestras o una muestra puede extenderse a través de
multiples enteros. Por ejemplo, si usa enteros de 32 bits, pero el dispositivo usa
muestras de 8 bits, un entero contiene hasta cuatro muestras. Si usa enteros de
8 bits, pero el dispositivo usa muestras de 16 bits, una muestra puede requerir
dos enteros. Este comportamiento varia de un dispositivo a otro. Se debe
consultar la documentaciéon de su dispositivo para obtener mas informacion.

NI-DAQmx no separa los datos sin procesar en canales. Devuelve datos en
una matriz 1D intercalada o no intercalada, segun el orden sin procesar del
dispositivo. Consulte la documentacion de su dispositivo para obtener
mas informacioén.

Little Endian 16-bit integer values (2 bytes = | integer value)

0 1 2 3
BEER
j , data = bytes Dand 1
Q data = bytes 2 and 3

Big Endian

or [es[2A] =1

[} 1.2 3,

— —
EPER

| Q
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Raw data

En adquisiciones continuas, la velocidad a la que LabVIEW puede recuperar
datos del bufer de adquisicidon y luego transmitirlos al disco es crucial. Debe
poder leer y transmitir los datos lo suficientemente rapido para que el
dispositivo DAQ no intente sobrescribir los datos no leidos en el bufer circular.

Para aumentar la eficiencia de la recuperacion de datos, debe evitar ejecutar
otras funciones, como las funciones de analisis, mientras la adquisicion esta
en progreso. Ademas, se puede configurar DAQmx Read para devolver datos
binarios sin formato en lugar de datos de voltaje (seleccionando uno de los
modos de datos Raw. Esto aumenta la eficiencia de la recuperacion, asi como
la transmision.

Cuando configura DAQmx Read para producir solo datos binarios, puede
devolver los datos mas rapidamente al bufer que si se utilizara los modos de
forma de onda analdgica o voltaje. Una desventaja de leer y transmitir datos
binarios es que los usuarios de otras aplicaciones no pueden leer facilmente el
archivo.
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' My_Data - Notepad Jo&d
Fle Edt Format View Help
] @A~ ?t ~
& " )@ 4+ 5, 9 4y° (YA SyL #yh "yl # N
040, # %yl 'YW SYN "yu ve §$7a !
+op DAY R V0 UE YA ST Cu
f 5;\ngyu&yp"'y$ry;xg§‘(q+g'%
" = v EN IV V) &N MR BT IR LA
- . o (= % 1Y K B&-)OE™, 74y ‘YA
My“‘m'a tlot’pad L“——' #;ﬁgfl 1’31 #yL &j " T +2, " Wy s{fw S%"
"va A4 L v -, 0, 0 %" YR OSYN
Fle Edt Format Wiew Help %YO B c jyu g,yf &o ‘,;g “5. %Yg
p.671 0.604 0.736 0.378 0.254 |a PRI 4 P gl ity B R
9'10{: 0.397 0.709 0. Oas,' L:'I' 339 T‘:I %y;f E:"E E;:. %y% ’;% fyl' 2 '9 % : 2 2 B My Generic Measurement File.abc - Notepad Q@@
0.386 0.527 0.826 0.446 0.364 “5; 5% W: #ﬁ ’y; 2 g ey z +y3 3”11 = .
0.209 0.496 0.766 0.236 0.243 s BN Y Ty / e
- - - #o0xo0 (-~ . % i ]
0. 694 0.559 0.766 0. 340 U.%ls ”Yy‘é #Y| f25 E F T i fy? E;g ;;E #));T My Generic Measuremer:'t File
0.293 0.283 0.833 0.141 0.66%9 : LH 3= J s L P tys ?‘L $yL #yg "yt Test_operator gggg}gzms
0.339 0.738 0.138 0.431 0.093 S E o A o ol S X writeTime  18:01:34.604
0. 340 0.838 0.603 0. 567 0.817 T ,ylj :')’T &P #a 'y " I’] £ (4" pescription This file contains voltage data from five thermocouples.
0.546 0.929 0.239 0.540 0.702 G Jyw &N Y ETXD) O+, M wisgnd_of _Header v ¥
0.929 0.522 0.955 0.419 0.725 g R e LT R ——T -
G - 725 * X . =
0.019 0.362 0.644 0.405 0.363 < Y Lt 5 5;22'?55510? 100 100 100 100
0.419 0.183 0.142 0.213 0.667 Thermocoupie_Type o J B - 2
hannel 8.620258 11.523453 21.440928 9.585559
0.994 0.473 0.336 0,335 0.438 Ehiﬂﬂiﬂﬁ ; /0.034131 ? /o. saszé; 3 /1.53‘5365 A /2.235531 4
0.690 0.580 0.778 0.835 0.981 bae  “2005/08/05  2009/0g/03 " 2000/08/03  2008/08/03" " 2009/c
0.456 0.374 0.687 0.337 0.163 Eﬂgﬁt,qbé'\ : volts vg'its' volts vc.ﬂ'ts‘ ‘vx‘ﬂts o =
- - Dimension Tim: Timi Tim Tim Tim
0.046 0.170 0.031 0.715 0.854 G 0T000Ek0 T 0.000E+0 T 0.000E+0 - 0.000€+0 0. 000E
0.419 0.833 0.071 0.307 0.657 pelta_x 0.001 0.001 0.001 0.001 0.001
e g fus de te
' 853 '153 I:l- gl 0' i s 225 voltage_0 voltage_1 voltage_2 voltage_3 voltage_d4
0. 0.152 617 111 0.23 0. 034181 0.565203 1.598865 2.285831 3.078097
0.502 089 0.4 0.%91 0.875 ni | Dot | |gemm || gde | | EERn
gg{g 333‘5 ggfg 83?3 8‘;%10 1.986755 2.779321 3.187963 4.002532 4.682150
2.648091 3.437300 3.848079 4.966277 5.576342
* f O 3 et 5 2.864162 3.930174 4.454176 5.257424 5.866878
0.151 0.974 0. 544 0.679 0.249 v 3.555712 4.565264 4990081 5.990173 6. 342662
3.877682 4.656514 5.795770 6.304819 7.136448
4.543901 5.275430 6.055177 6. 619160 7.080599
5.078280 5.651112 6.550343 6.941130 7.811213
5. 679189 6.277047 7.207251 7.364422 7.903713
6.457411 6. 583148 7.674184 8.105716 8.107242 -
< >
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Entrada/Salida con ficheros

Binario. Fichero base del resto de formatos de ficheros.

ASCII. Un fichero ASCII es un tipo especifico de fichero binario en el que se
utilizan la codificacion ASCII. También se denominan fichero de texto.

LVM. Fichero de datos de medicién de LabVIEW delimitado con tabulaciones.
Se puede abrir con editores de texto. El fichero .lvm incluye informacion sobre
los datos, como la fecha y la hora. Este formato de fichero ASCII creado por
National Instrument para LabVIEW.

TDMS. Este formato de fichero es un tipo especifico de National Instrument.
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o Estructura interna del formato de archivo TDMS

B My Generic Measurement File,abc - Notepad

- My Generic Measurement File

L Test_operator perrick
Description write_bate 2009/04 /05

Data Set (File)

T‘m write_Time 18:01:54.
e pescription This file contains voltage data from five thermocouples.
Author wwwend_of_Header %

. ,etc_ Channels 5
Samples 100 _ 100 100 100 100
- Tnermogaum e_Type 3 | b ]
Channe]_mMax B8.620258 11.523453 21.440928 9.585559
Channel Group(s) «UUT ChannelMin  0.034181 0. 565203 1. 508865 2. 285531
Date ~2009/08/05 2009/08/05 2009/08/05 2009/08/03 2009/¢
1 54 18: 18:01:54 18:01:

Time t01: 101:5 18:01:54
* Procedure Y_u?h_l.:beI vghs vghs
= *_Dimens ion Time Time e
* Test Fixture %0 0.000E+0 : 0. 000€+0 0. 000E+0 0.0008
> &R pelta_x 0.001 0.001 0.001 0.001 0.001
: wwwgnd_of _Header

voltage_2 voltage_3 voltage_4
1. 598865 2.285531 3.078097

73324 2.876675

90512 3.775750
3.187963

8079

Name
» Comment
Unit
« Sensor Info
O G

WNNNNO s B

.457411 6.583148 7.674184 8.105716 107242

A OB W

Master de Ingenieria de Telecomunicacion Sistemas de instrumentacion 100



Y ma
“—l Edicion de fichero TDMS

DE MALAGA

HU IR2pple
iPhone 3G Eo |LCD Test
Speaker Test
EG Manufacturer 4 ]
Model

File Size (in bytes)

I

1C:\Cell Phone Testing.tdms }““ﬂ H o
[ create or replace v}
T
Create TDMS Write Custom Stream Data Close File View File
File Properties to File and Size
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ST Directorio Data

MALAGA

IZI Options

Category

Front Panel

Block Diagram -
Controls/Functions Palettes Default Data Directory™ Use default

Environment C:\Users\34626\Documents\LabVIEW Data o~

Search

Printing

Source Control

Menu Shortcuts
Revision History
Security

Shared Variable Engine
VI Server

Web Server

Browse...

Insert Before Insert After Replace
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Entrada/salida de fichero de alto nivel

Algunos de los Vis de E/S en fichero permiten realizar los 3 primeros pasos del
proceso de E/S: abrir, leer/escribir y cerrar. Si un VI realiza los tres pasos se
denomina VI de alto nivel. Estos VIs no son eficientes como los VIs de bajo nivel
disponibles también en LabVIEW. Se recomienda el uso de los Vls de bajo nivel
cuando se accede a un fichero en un bucle.

Los Vis de alto nivel incluidos en LabVIEW son los siguientes:

« Write to Spreadsheet File: convierte un array 2D y 1D de numeros de doble
precision en una cadena de caracteres de texto y escribe ésta en un fichero
ASCII. El VI permite crear o abrir un fichero, escribir en él y cerrarlo después.

 Read From Spreadsheet File: Lee un numero concreto de lineas o filas de un
fichero de texto numérico empezando por un desplazamiento de caracteres
concreto y convierte los datos en un array 2D de numero de doble precision. El
VI abre el fichero, lee y lo cierra.

« Write to Measurement File: escribe datos en un formato de fichero de medidas
basado en texto (.lvm) o en un fichero de medidas binario (.tdms). Se puede
especificar el método de guardado, el formato de fichero, el tipo de encabezado
y el delimitador.

 Read from Measurement File: Permite leer de un fichero .lvm o .tdms.

Master de Ingenieria de Telecomunicaciéon Sistemas de instrumentacion



Entrada/salida de fichero de bajo nivel

e
-

Open/Create/Replace File = E( ¥==%]|error out

Write to Text File
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Escritura de alta velocidad NI-DAQmx a Disco

<1 Measurement I/O

DAQmx - Data Acquisition

=

<21 DAQmx - Data Acquisition

- Thsk |} [ CHAN] ]
— Task Const Channel Const
NI SCOPE

Dfitmx

<1 DAQmx Advanced Task Options

DAQmx Configure Logging.vi

1 Create Task Control Task

]?

Comparison

—

DAQmx Advanced Task Options

DA mx
DO

Create Channel Read

Dt mx

Is Task Done Wait Timestamp

Start New File

Logging

DA mx DA mx
= || B

DA = DA
Input Buffer Output Buffer
P2ZP
| [=¢] |
— EJ
Peer To Peer Task Node Buffer Node
Streaming
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DAQm Signals

el

Waveform

-

DA
wéte

Write Node

=
Task Config/Ctrl

&«

=2
Collection

% |

Advanced
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Compresion de Datos

Minimum Yalue
[CoBLy

[ioh u E - DAQmx Channel ﬂ
Anh — Al RawDataCompressionType

Al Volcage ~ | —|".|'-'l.I .LossyLSBRemoval. CompressedSampSize

ata Compression Typel

EussE LSB Removal Sample Size|

&
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t- ot
Analog Wfm
<21 Waveform Generation
Formula Waveform.vi reset signal
B B | =
frequency
Basic FuncGen  Tones & Noise Formula Wfm L E
: : o amplitude Wavet Granh
= é E ﬁ _ aveform Grap
Formula j
Sine Wfm Square Wfm Triangle Wfm Sawtooth Wfm by
B B E &
Basic Multitone Multi with Multitone Gen r
Amps 5
.................... 1000
‘i il ﬁ ﬁ #s
1000
Uniform Wfm Gaussian Wfm PRN Wfm I £ WEm o
B & (] =
| | | = 2]
Gamma Wfm Poisson Wfm Binomial Wfm Bernoulli Wfm
oS
Simulate Sig Sim Arb Sig
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.  Signal generation Vls

| Functions

Q, Search 4, Customize® =1

| * Mathematics

|+ Signal Processing

L Signal Generation

SigGen Duration  Tones & Noise  Gauss-Mod Sine

Sinc Pattern Periedic Sinc

Sine Pattern Triangle Pattern Pulse Pattern

Ramp Pattern Chirp Pattern Sine Wave

[fos]

i
i
L

Triangle Wave Square Wave Sawtooth Wave

Unifarm Noise Gaussian Moise

[f]=c] [[=z]
Periodic Binary MLS Impulse Pattern
Random Moise
EE= EE=E EE=2
]
Gamma MNoise Poisson Moise Binomial Moise
[& | [J=o] [& |
Bernoulli Moise Pulse Train Quasi Rand
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‘:LSearch &, Customize
| » Mathematics
[ » Signal Processing
| » Data Communication
[ ¥ Connectivity
|| » Contrel & Simulation
|- Express
L Input

DAC Assist Instr Assist

A

Instr Drivers imulate 5i

N
&

Sim Arb 5i Acquire Sound
&

Read Meas File Prompt User E
D 3

(Y]

i
<

Simulate Signal

Sine K

error out *

¥

Ferror in (no erro

B Configure Simulate Signal [Simulate Signal]

Signal
Signal type
Sine
Frequency (Hz) Phase (deg)
10.1 0
Amplitude Offset Duty cycle (3
1 0 50
[] 4dd noise
Moise type

Uniform White Moise

MNoise amplitude Seed number Trials

Timing
Samples per second (Hz)
1000 () Simulate acquisition timing

Mumber of samples (®) Run ac fast as possible

100 [] Automatic

] Integer number of cycles

Actual number of samples
Actual frequency

Result Preview

Amplitude

Time

Time Stamps
(®) Relative to start of measurement

() Absolute (date and time)

Reset Signal
() Reset phase, seed, and time stamps

(®) Use continuous generaticn

Signal Name
Use signal type name

Signal name
Sine

(o] 4 Cancel

Help
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,

* 1]
. Simulate Signal . .
4+ QSearch ‘\Custclr‘mze' Sine i Original signal
Signal Analysis
— —— 3 Y Sine Wave

= freverery i 1Hz
hha, Filtered signal

z
Input Signal Analysis Output Sig Manip . QE
: =
— 8 -
2 Simulate Signal | Filter
@ I = Sine p' Signal X C 1
Exec Control Arith & Compar Sne W Filtered Signal ep Spectral
v E d Measurements | gipered signal PSD
UL a7 il Signals =
PED
Filter Lower Cut-Off
8 (=T
& _
13 L3 FZD
Simulate Signal r ¥
Sine ] Spectral
Measurements
Sine Wave = Original signal P5D
100 Hz bk Signals
PsD
=
13 L
Simulate Signal
DC S
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Filter Lower Cut-Off

e =125 : :

| Sine : ~ : ine [Fi
Original signal, i m | Filtered signal \ 5ine (Filtered) m |
me e e s m S s e e NV Ty of ’ -
1 25_ 1
! 20-
| = 10- [ 2
] o ! o

E E
?' < 'E <
: '5_| I I 1 I I I I I I 1 :
! 0 1 2 3 4 5 & 7 8 9 10 |
! Time '
A _— .

Original signal PSD | Sine (PSD) L~ ) Filtered signal PSD

100-

Amplitude

1 1
= [
(=] =]

| |

Amplitude

| 1 1 1
0.1 1 10 100 1000
Frequency Frequency
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| Express
L Signal Analysis

- Mo A A
Spectral Distortion Tone 2 Chan Spectral
Amp & Level Timing-Trans Curve Fitting
&
Statistics Conv & Corr Simulate Signal Mask & Lirnit
Histogram
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Filter - Bass

Signal

Filtered Signal *

DAQ Assistant

k

k

Filter - Midtone

data

e

[

Signal

Filtered Signal *

e

3

.

Filter - Treble

Signal

Filtered Signal *

S
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Spectral
Measurements
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Phase r
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Filter Express

Show Noise Plot? Waveform Graph

: -
________________________________
TF

Amplitude |

)

23y 4 .
Simulate Signal Filter
Frequency Sine with Unifor* » | Signf"l |
d Filtered Signal ==~
|.,

13
Noise amplitude !

Jizsh
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Q Search " Customizev TH

Control Generation " E q Search % Customize™
| » Measurement |/0 | Measurement /0 ~
[[» Instrument /0 || P Instrument 170
[ » Mathemnatics [ » Mathematics

[* Signal Processing [* Signal Processing

L Transforms
i = =
Wfm Generation  Wfm Condition Fix) Hilbert
— — FFT Fast Hilbert
sy
~Aylly i
e = =
Wm Measure Sig Generation Hartley "'1-!“
— — FHT WeltDaubchiesd
T i
= =
Sig Operation Windows fall AR
—— — Walsh DCT
Hadamard
LA, UL, .
(=3 (=3
Filters Spectra == a
A DsT Chirp Z
o
[aZ
A = =
Point By Point e, 3 T s}
Laplace Inverse FFT

| » Data Communication

[ » Connectivity
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) Spectrum
sampling freg i frequency spacing | P zm
: i '
£ of | FFT.vi
# of samples iz ‘;:;} b
Complex To Polar
frequency (Hz) || e Sine Wave.vi
hz3h EES Time Domain Waveform

|> Array Size
i

Time Domain Waveform

frequency (Hz) I 1— RErYRR P
|||||H

Efioo | | N TRl |
~ 0518 | ||
||||| | I ||||||||

*DBL Mumeric Control *

Amplitude

- i
s?mpllngfreq 0 || |

={[100.00 | s

= DEL Mumeric Control *

Amplitude

| | | 1 1 1 | | | |
oo 0 20 30 40 50 60 V0 80 90 100
Time

# of samples 0 10 20 30 4 50 60

=i [100 ,
: * Waveform Graph *

-

*132 Mumeric Control * * Waveform Graph *
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[ ot [ 1]
FFT rnagnitude L F_I__.._I = .I.._ J
b5
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[F]
:"é B3-
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ED02-
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Procesamiento punto a punto

Mext Array

Array-based Analysis .
A-t:quwau:l M Raw Signal

B Current Acquisition
Current Acquisition M Acquired Data

Frocessed Data

Point-by-Point Analysis
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File 170

e

Synchronization

O

=Y

Report
Generaticn

Measurement |/0
Instrument /O

Mathematics

Connectivity

Express

Addons
Select a V...

Control & Simulation
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Graphics &
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Application
Control
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Compare Point-by-point and array-based Filtering

Generate signal and filter every point. |“
Filter signal with the Butterworth
) Ml Filter V1.
Generate Signal. Signal (sine plus noise) La
i = [ ¥DEL] Filtered Signal (Array Based)
IL e, FDBL]
Filter signal with the Butterworth
0.01 el Filter PtByPt V1. ﬁ'
Filtered Signal (Point-By-Point)
B | D T J Y m - T x — DB
0 D ¥Histor i [TE K-
] ] ] ] Initialize Array-based filter
Filtered Signal (Point-By-Point)
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